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Chapter 2

Installation

AmiBroker runs under Windows, including versions 95, 98, Millen-
nium, 2000, NT, XP, and Vista. Both 32 bit and 64 bit operating systems 
are supported.

All versions of AmiBroker – trial and registered, standard and profes-
sional, end-of-day and real-time – begin with a visit to the AmiBro-
ker web site and downloading the installation file. Using your Internet 
browser, visit http://www.amibroker.com, then select the download tab. 
Select either the file for a New and complete installation or an Upgrade 
installation. If this is your first installation of AmiBroker, choose the 
New installation. Download the file to your computer – the New instal-
lation is about 7 MB. When the download is complete, double-click the 
installation file (AmiBroker510.exe, or the latest version) to run the Ami-
Broker Setup Wizard. Follow the directions and answer the prompts.
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Both AmiBroker and this author recommend accepting the default op-
tions and file locations during installation.

When the installation is complete, launch AmiBroker. The installation 
will have created an AmiBroker icon on your desktop. Just double-click 
that. When AmiBroker starts, it displays a message that it is Standard 
Edition and Unregistered. This is the trial version, but will be instant-
ly converted to Registered (and Professional Edition, if you requested 
that) when your AmiBroker Registration file is processed.

In the mean time, AmiBroker is ready for your use in Trial mode.
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AmiBroker in Trial Mode

AmiBroker in trial mode is fully functional with a few exceptions.
The trial version will run only 30 days. To run longer than 
that, it must be registered.
When processing multiple symbols, the maximum in the trial 
version is five; the registered version handles an unlimited 
number.
Changes, particularly to the database, will not be saved. Also, 
if you modify one of the chart panes, the changes you made 
will not be saved when AmiBroker closes. 

Default Database

When you install AmiBroker, a small database is also installed. Its name 
is DATA and it contains end-of-day price history for the stocks in the 
Dow Jones Industrial Average and for the average itself. The date range 
is short and the quotes are not up-to-date. But it is useful for verifying 
that the installation was successful and for investigating AmiBroker.

You can use AmiBroker and the default database while in trial mode. 

•

•

•
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Chapter 3 ‑ 30 Minutes to Useful Results, has some suggestions.

You will probably want a longer history and more issues. You can have 
as many databases as you wish. DATA is one. You can expand it or add 
other databases.

Block Diagram of Database

As the block diagram shows, AmiBroker has two levels of database 
files.  The native database is maintained by AmiBroker and AmiQuote, 
and can be modified by you using the Quote Editor within AmiBroker. 
The DATA database is an AmiBroker native database. 

When you subscribe to a data provider, that provider will set up an 
external database that they exclusively maintain. As AmiBroker needs 
quotes to place on a chart or process in a backtest, the Data Plug-in 
reads the external database and passes the data to AmiBroker. 

Database Setup ‑ End-of-Day

Setting up a database is a two step operation. Step one is establishing 
the database within AmiBroker and specifying which tickers will be 
stored in it. Step two is filling the database with historical price quota-
tions. Depending on the processes being used, you may be aware of 
the two separate steps, or they may be combined and appear to you as 
a single step.

If you will be subscribing to a data service, such as Quotes Plus, the 
installation procedure for that service will set up a database specifically 
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for quotes from that service and will be maintained by that service. We 
will discuss setting up a Quotes Plus database in a few pages.

If you want to use one of the free data providers, such as Yahoo, you 
can either expand DATA or create a new database. The following pages 
describe how to do that.

Free Database Using AmiQuote

AmiQuote is a companion program to AmiBroker that manages down-
loading of price quotes, from either Yahoo or msn, and storing those 
quotes in the AmiBroker database.

Return to http://www.amibroker.com and download the setup file for Ami-
Quote. The current version is 2.00. Double-click aq2000.exe and follow 
the installation instructions, accepting the defaults.

If the only information about the stocks that you want is their ticker 
symbol, then continue with the method described in the next few para-
graphs. If you want to have the ticker and full name, and perhaps the 
industry sector identification, read the next section, Ticker Only; then 
read the section, Ticker and Full Name, that follows. It is a good idea to 
decide this before the database is filled with historical quotes.
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Ticker Only

Begin by deciding which issues you want in your database. Find or cre-
ate a list of their tickers. This does not need to be the final list – you will 
be able to add additional tickers and historical data at any time in the 
future. For example, you might want all the stocks in the Russell 1000 
index – the 1000 largest capitalization stocks listed on US exchanges. 
(According to the Russell Investments website, http://www.russell.com, 
the Russell 1000 represents approximately 92% of the US equities mar-
ket. That website also has a list of the current components of all the 
Russell indices.) Visit http://www.IntroductionToAmibroker.com/resources 
for links to up-to-date lists of members of various categories.

If you want to keep a copy of the original DATA database as it was dis-
tributed, here is how to make a copy of it. 

Using Windows Explorer, navigate to the AmiBroker 
directory. If you accepted all the defaults during installation, it 
is C:\Program Files\AmiBroker. 
With Explorer, using the File menu, click New, then Folder. A 
folder named New Folder will be created. 
Using Explorer, rename that to the name you want for the 
original database, for example DataAsDistributed. 
Using AmiBroker and its File menu, click SaveDataBaseAs, 
select the folder you just created, DataAsDistributed, click 
OK. AmiBroker will make a copy of the DATA database in the 
folder DataAsDistributed.

Continuing on to update the database named DATA with the tickers in 
the Russell 1000. 

Using a simple text editor, such as NotePad, or a spreadsheet, 
create a file with one ticker per line. The tickers should be in 
all capital letters. Each ticker must be spelled the same as your 
data provider spells it. Save that file in the AmiQuote directory 
with a meaningful file name, such as Russell1000.tls. If you 
accepted all the defaults during installation, that directory is 
C:\Program Files\AmiBroker\AmiQuote. Tls files are ordinary 
text files that are recognized by AmiBroker and AmiQuote as 
containing lists of ticker symbols.
Open AmiBroker. 
Using the AmiBroker File menu, click Open Database, select 
the DATA database, click OK. 

1.

2.

3.

4.

1.

2.
3.
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Leave AmiBroker open as the next steps are performed.
Decide the date you want the historical data to begin. If you 
plan to do extensive trading system development, I suggest 
having at least ten years of data available. The characteristics 
of the markets changed after the October 1987 crash, so data 
before that date has limited value in developing systems for 
current conditions. A starting date (From Date) of 1/1/1995 
might be reasonable. Use today’s date for the end date (the To 
Date).
Using the Windows Start menu, select the AmiQuote 
program and run it. You will find it under All Programs > 
AmiBroker > AmiQuote > AmiQuote. 
Using AmiQuote’s File menu, select Open. Then select the file 
with the tickers you want to get historical data for, Russell1000.
tls, and click Open. 

Be sure that AmiBroker is running and that the database 
you want updated is the current database. The name of the 
database in current use is displayed in the status bar in 
the bottom right-hand corner of the AmiBroker window. If 
necessary, use the AmiBroker File menu and open the desired 
database.

4.
5.

6.

7.
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Be sure that AmiQuote’s Automatic Import box is Checked.
Click the Green Triangle to begin the download.  

You have asked for over 10,000 years of data, each with 252 sets 
of Open, High, Low, Close, and Volume. Depending on the 
speed of your Internet connection, it will take a few minutes to 
a few hours for the download to complete. 

AmiQuote will inform you of the progress of the download. 
If the amount of data stretches the capacity of your 
communications or your patience, divide the Russell1000.tls file 
into several smaller files and work with each part in turn. 
As soon as the data for any individual stock has been 
downloaded, it is immediately available for use within 
AmiBroker. You may continue to work with AmiBroker while 
downloading proceeds. 
 
When the download is complete, scroll through the Ticker List 
in AmiQuote. If there were problems with any of the tickers, 
there will be messages displayed. A common problem is that 
the spelling of the ticker in the tls file is not the same as the 
spelling the data provider uses. In this case, note that Russell 
Corporation used a period when specifying the Class A stock. 
Yahoo uses a dash character. Make a list of all the tickers that 
did not download properly and create a file named NewTickers.
tls. Add the tickers of any other stocks you want. Using the 
same procedure, have AmiQuote download the new tickers. 

8.
9.

10.
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A good source for researching companies and verifying tickers 
that will be downloaded from Yahoo is the Yahoo financial 
site. http://finance.yahoo.com/
Close AmiQuote.
In AmiBroker, using the File menu, click Save Database.

Ticker and Full Name

If you want AmiBroker to know the full name of each issue in addition 
to its ticker symbol, the names must be loaded into the database. One 
way to do that starts with a text file, similar to the Russell1000.tls file 
described above, but including the full name of the issue along with 
the ticker symbol. Optionally, the industry group number can also be 
included and will be used to place each ticker in its correct category. 
Each line of this file has the ticker, full name, and industry group num-
ber, all separated by commas, and saved in a file with a name such as 
R1000FullName.txt (txt, not tls, as you will see in a minute).

Appendix B, Industries and Sectors, has a list of the industries and 
their respective group numbers. There is no simple way to assign an 
industry, and its associated industry number, to each ticker. At times, a 

11.
12.
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database of a large number of stocks (such as all US stocks), sometimes 
including a program to set up a database that is complete with industry 
number assignments, will appear on one of the AmiBroker discussion 
forums (see the links in the Appendix C, Resources). These quickly be-
come obsolete with the addition of new stocks and changes to existing 
ones.

If you are very interested in assigning industry numbers to stocks, here 
are two alternative ways.

One. Download the lists of components of each of the Standard & Poor’s 
sector exchange traded funds. One sector at a time, form a watchlist 
of the members. (See Watchlists, page 179.) Using AmiBroker’s Symbol 
menu, select Organize Assignments and assign all the members of the 
watchlist the same Sector Number.

Two. Subscribe to one of the commercial data providers (see the links in 
the Appendix C, Resources). In the process of setting up their database, 
they will assign each stock to its proper market, industry, and group. 
Most of the services will store additional information, such as number 
of shares outstanding, dividend, and so forth, that you would have dif-
ficulty finding yourself.

With R1000FullName.txt, the file containing the ticker symbol, full name, 
and optionally the industry number ready, you are ready to establish 
the database. This must be done before symbols are entered in any oth-
er way and before quotes are downloaded.  A simple jscript program, 
Industries.js (courtesy of Tomasz Janeczko), can be used to read the txt 
file and establish the database. (The program listing of Industries.js is in 
Appendix C, Resources, and is in the download materials associated 
with this book.)

Warning: If your database is already established and has historical 
price data, Do Not run this script – it will result in a badly confused 
database. Use this script only to establish a new database before load-
ing historical quotes into it.

In order to run the script:
Using Windows Explorer, create a new folder under the 
AmiBroker directory to hold the new database. Assume it is 
NewR1000.
Run AmiBroker, use the File menu, Open Database, select 
NewR1000, click OK.

1.

2.
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Copy or move R1000FullName.txt to your Windows Desktop.
Copy or move Industries.js to your desktop.
Double click Industries.js.

The script tells you that the script is started. Click OK.
After a short time, less than one minute, the script tells you it 
is finished. Click OK.

Verify that the script worked by using AmiBroker Symbols menu. Ex-
pand the All category and note that there are 1000 tickers listed. If you 
supplied industry codes, expand the Sectors category and note that the 
tickers have been assigned to sectors. There are no quotes yet.

To fill the database with historical quotes:
Create a .tls file containing the tickers from the first column of 
R1000FullName.txt. Name it Russell1000.tls.
Follow the directions given in the section above, Ticker Only, 
to have AmiQuote retrieve historical data from Yahoo.
In AmiBroker, using the File menu, click Save Database.
Exit AmiBroker.

Additional Symbols

Whenever you want to add issues to your database, use this proce-
dure:

Enter their ticker symbols, one per line, in the file NewTickers.tls. 
(It is convenient to keep all tls files in the AmiQuote directory.)
With AmiBroker running, open the database you want to add 
to.
Run AmiQuote.
Using AmiQuote’s File menu, open NewTickers.tls.

3.
4.
5.
6.
7.

1.

2.

3.
4.

1.

2.

3.
4.
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Set the From Date and To Date.
Check the Automatic Import box.
Click the Green Arrow to begin the download.
When the download is finished, close AmiQuote.
In AmiBroker, Save database.

If you want to record the full name of the issue:
In AmiBroker, using the Symbol menu, select Information. 
The information window for this stock will open.
Edit the Full Name field.

If you want to assign categories:

In AmiBroker either:
Using the Symbol menu, select Information.
In the Categories section, make whatever assignments you 
wish for the one ticker you are working with.

Or:
Using the Symbol menu, select Organize Assignments.
Make whatever assignments you wish for the list of tickers you 
select.

Data Updates

Once the database has been established and the historical data loaded, 
maintaining the data by adding the latest quotes is very easy. In Ami-
Broker, using the Tools menu, select AutoUpdateQuotes. AmiBroker 
will examine the database that is open, determine the date range need-
ed to bring the quotes for all the issues in this database up to current 
date, and call AmiQuote to do the download. Since only a few days 
data is needed for each ticker, the process takes only a short time.

5.
6.
7.
8.
9.

1.

2.

1.
2.

1.
2.
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Sources of Free Data

The examples above illustrate using Yahoo as the source of historical 
data. There are other sources. For US markets, msn also provides free 
end-of-day historical data. If you wish to use that source, use the pull 
down menu in AmiQuote to select msn instead of Yahoo. Keep in mind 
that consistency is important. Different data suppliers will have differ-
ent ways of preparing and presenting the data. For example, the vol-
ume multiplier may be different, or the ticker spelling may be different. 
After you load your database with quotes from one supplier, keep the 
database up-to-date using that same supplier. 

ASCII Import

There are two methods of importing ASCII data: the ASCII Import Wiz-
ard (file menu, Import Wizard), and the full ASCII Importer (file menu, 
Import ASCII). The wizard is good for one-off imports. Its features are 
a subset of the full importer. If you will be importing the same files 
regularly, set up the full importer. (Note: the ASCII Import Wizard can 
create a format definition file for later use with the ASCII Importer.)

Before you start, decide which database you want the imported data to 
go into. If you are just practicing, create a test database and open it. Do 
not import into your high quality database until you are confident the 
import procedure is working correctly.

Download the data files and, if necessary, unzip or expand them. Open 
the files using a text editor such as Notepad. There should be one quote 
per line, fields separated by space, semicolon, or comma.

There may be a header line describing the fields. If not, identify the 
fields yourself. If necessary, go to the site from which the data was ob-
tained and read their documentation.

The date field is the trickiest. The wizard understands many formats. 
If your data is in one of them, all you need to do is identify the order 
of month, day, and year. The codes are DMY, MDY, YMD. If your data 
does not follow one of the recognized date formats, you will need to 
reformat the date (for example, by using a spreadsheet) and rewrite the 
data file before proceeding.

The year can be either four digits or two (the final two of the year). The 
month can be either two digits or three characters (such as Dec or Jan). 
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The day is two digits. The separator can be / (slash), \ (backslash), - (mi-
nus), or not separated at all.

Assume the date for one quote is December 31, 2000. YMD formats that 
are recognized include:

20001231

2000-12-31

2000/12/31

2000-Dec-31

001231

00-12-31

00/12/31

00\12\31

If your data has a ticker symbol as a field in each line, the data will be 
stored under that symbol. If there is not an explicit ticker, the file name 
will be used. If your data file is downloaded as, for example, IBM.csv, 
the data will be stored as IBM. If your data file is downloaded with a 
generic name, such as Table.csv (Yahoo uses this file name for all its in-
dividual downloads), rename it before proceeding.
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Yahoo Historical Data Download

The Yahoo site is a good place to get stock and index historical data.
http://finance.yahoo.com

Using the investing tab, select stocks. Under research tools, click his-
torical quotes to get this page.

Follow these steps to download the historical data for a stock or index:
Enter the ticker (say it is XOM)
Click GO
The screen will display the most recent data
Click Download to Spreadsheet 
On your desktop, or wherever your default directory to receive 
downloads is, you will find a file named Table.csv. 
Rename Table.csv to XOM.csv. Use capital letters if you want 
your symbol to be in capitals.
Proceed to import XOM.csv into AmiBroker using either the 
ASCII Import Wizard or Import ASCII

1.
2.
3.
4.

5.

6.
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ASCII Import Wizard

The following steps illustrate how to use the ASCII Import Wizard. Be-
fore beginning, a database named Test has been created and opened. 
It already has a few symbols and data for them. Data has been down-
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loaded from Yahoo for two stocks, GE and XOM, but not yet imported. 
Since Yahoo downloads all data using the file name Table.csv, the down-
loaded file was renamed between downloads, so the files are GE.csv 
and XOM.csv.

Using the File menu, select Import Wizard. 
When the dialog box opens, click Pick Files. 
Navigate to the directory holding the files you have 
downloaded. 

Since the files have identical formats, you can process multiple 
files in one pass, so select both GE.csv and XOM.csv. (Click one 
file, press the Control key and click the other.) 
Click Open.

The Define Fields dialog box will open.
Note the format of the data in the .csv files.
Using the pull-down menus, define the fields for each element 
of data. Each element in the entire row of data must be defined. 

1.
2.
3.

4.

5.

1.
2.
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Select SKIP to ignore data in the csv file that you do not want 
in your AmiBroker database.
Select comma as the separator.
Skip 1 line ‑ the header.
Check Automatically add new symbols.
Click Next. 

The Additional Settings screen will come up. It is on this 
screen that you can save the format settings that you just 
used. They will not help for future uses of the ASCII Import 
Wizard, but they will be available in the full ASCII importer.  
To do this, Check Add current settings to ASCII importer 
definitions, and give meaningful Description and File Name. 
You will see your format as we look at the full ASCII Importer 
in the next section.
Click Finish.

3.
4.
5.
6.

7.
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The data will be converted from ASCII, imported into the open data-
base, and be immediately ready for use in AmiBroker.

ASCII Importer

The full ASCII Importer is much more efficient, has more capabilities, 
and is more complex. Rather than having to fill in a form each time you 
want to import an ASCII file, you can set up a format definition file, or 
use one of the pre-defined files. The file that was created for the import 
done manually using the wizard in the previous section is:

# Format definition file generated automatically
# by AmiBroker’s ASCII Import Wizard
$FORMAT Date_YMD, Open, High, Low, Close, Volume, Skip
$SKIPLINES 1
$SEPARATOR ,
$CONT 1
$GROUP 255
$AUTOADD 1
$DEBUG 1
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The definition files are stored in the C:\Program Files\AmiBroker\For-
mats directory. By copying the format file that you will be using regu-
larly to be DEFAULT.FORMAT, all that is necessary to import ASCII files 
is:

Using the File Menu, select Import ASCII.

On the Open screen, select the file you want to import.
Click Open.

The file will be converted, imported, and made available within Ami-
Broker for immediate use.

The options available for controlling the processing of ASCII data are 
extensive. Read about them all in the AmiBroker User’s Guide.

1.

2.
3.
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Subscription Data Providers

Free data has a cost to you – the cost of checking the data for missing 
quotes, bad values, unadjusted splits, and so forth, and correcting those 
problems. Subscription data services, such as Quotes Plus, Premium 
Data, CSI, and others, provide that maintenance for you and deliver 
cleaner, more consistent data with less effort on your part. End-of-day 
stock data costs about $40 per month – more for some services, less for 
others. Some end-of-day vendors include mutual funds at no charge; 
others charge extra. Commodities and futures data is an additional 
cost, depending in part on the fees the exchanges that clear those trades 
and report that data charge. Some subscription vendors provide cus-
tom indices, custom indicators, and have a wider selection of issues 
– and often charge an extra amount for those. Some services charge a 
one-time fee for loading the historical data, others do not.

If you plan to use a subscription service, be aware that each service has 
its own database format. Once you begin with one subscription service, 
they will be the only service that can keep your data up-to-date.

The installation procedure for each service will be unique to that ser-
vice, but it is generally simple and well documented. Typically, the in-
stallation does three things for you:

Establishes the external database and the communications 
between the database and AmiBroker.
Loads the definitions of the tickers, including the ticker 
symbol, the full name, and the industry assignment.
Loads the historical price data.

After the close of trading each day, you initiate communication with 
the data vendor. The database is brought up-to-date, and errors and in-
consistencies are corrected and re-downloaded, all automatically. Some 
vendors provide intraday updating – treating the latest price as though 
it is the closing price. At subsequent updatings, the earlier prices are 
replaced by the more recent ones.

Quotes Plus End-of-Day Data

Here is the procedure to set up a Quotes Plus subscription end-of-day 
database.

Each data provider will have their own specific details and methods, 

1.

2.

3.
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but the end result is the same – an end-of-day database that is estab-
lished and loaded with historical data by the data vendor. Tickers, full 
names, industry associations, and other information related to that 
stock are all provided by the vendor, stored in the external database for 
that subscription, and made available to AmiBroker through an inter-
face that is transparent to you as a user.

Begin with a visit to Quotes Plus’ website: http://www.qp2.com/
joomla/index.php.
Pull down the Products menu, select QP3, and click Free Trial.

Fill in the contact information. You will receive an email from 
Quotes Plus containing a User ID, Password, and the URL link 
to a download utility.
Follow the link to the download utility and download the 
Qp3Setup.exe file. 
Execute that file to start the installation of the database and 
download of the historical quotation data. This is the first 
screen you will see. 

As you follow the instructions, you will be asked for your User 
ID and Password.

1.

2.

3.

4.

5.
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Select the data files you want.

Accept the defaults for the location of the program (which you 
will use to keep the data up-to-date) and the data files. The 
path to the program will be C:\Program Files\Quotes Plus, and 
to the data files will be C:\Quotes Plus Data.
When the download is complete, click Finish.

If you selected the stock data, mutual fund data, and commodities data, 
the total data transmitted will be about 260MB. If that will strain your 
communications capabilities, Quotes Plus will mail you a CD.

Connect the database to AmiBroker.

In AmiBroker, from the File menu, select New, and Database. Working 
in the top half of the Database settings window:

In the Database Folder box, enter the name you want for your 
new database.
Check Load this database at startup.
Click Create.

6.

7.

8.

1.

2.
3.
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Now working in the bottom half of the Database settings window:
Pull down the Data Source menu and select Quotes Plus data 
Plug-in.
Click Enable Local data storage.
Enter 1000 for the Number of bars.
Click Configure.

On Configuration:
Select the categories you want in the database.
Click Retrieve. Wait while the data is retrieved.
Click Close. 

Back on Database settings, Click OK.

1.

2.
3.
4.

1.
2.
3.
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Your Quotes Plus database is now established, loaded with historical 
quotes, installed in AmiBroker, and ready for use.

To load a chart:
In AmiBroker, using the Symbols menu, expand the All 
category (click the + sign). 
Click on any of the ticker symbols. The data for that ticker will 
load into the main chart window.
In AmiBroker, Save database.

Norgate Premium Data ‑ End-of-Day

Norgate Investor Service provides quality end-of-day data for stock 
markets in Australia (ASX), Asia (SGX), and the United States (NYSE, 
NASDAQ, AMEX, OTC-BB, PinkSheets). Extensive historical data is 
available, including data for delisted stocks (an important feature for 
those interested in studying survivorship bias). 

The data integrates very well with the symbol lists, and includes over 
900 pre-built and automatically maintained watchlists for the Austra-
lian and US databases. Hourly snapshot data is available for the ASX 
and SGX. 

Data is provided in MetaStock data format. (If you are installing Pre-
mium Data as an AmiBroker database, you will not be aware of the 
format of the external database.)

Norgate also provides end-of-day data for 86 liquid futures markets. 
Futures data is available in individual, spliced continuous, and back-
adjusted continuous contract forms. All the fields required for serious 
backtesting (margin, point value, tick size, etc.) are populated. Data is 
provided in ASCII and MetaStock data formats.

Norgate is in the process of improving their integration with AmiBro-
ker. A new native AmiBroker data plugin that will provide additional 
speed and features is under development. Visit http://www.premiumdata.
net/support/amibroker.php for the latest details.

Free trials are available.

1.

2.

3.
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The next pages discuss setting up Norgate end-of-day data for the Aus-
tralian stock market.

Sign up for a subscription or free trial at their web site: 
http://www.premiumdata.net.

You will receive an e-mail with your user name and password, 
and a link to the download page.
Go to that web page and login.
The services you have subscribed to will be noted in the 
download screen. You will need to download at least three 
files: 
A.  Program Installer 
B.  History Installer 
C.  AmiBroker Setup. 

1.

2.

3.
4.
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Click on the server nearest to you (Australia, Europe or USA).
Save the files and accept all the defaults for file locations.
The Program Installer and History Installer must be in the 
same subdirectory on your computer.
Insure that AmiBroker is not running. 
Locate the program installer, run it and follow the prompts. 
The program installer will recognise the history installer and 
offer to install the history for you as part of the process. If the 
files are too large for your communications, you may prefer 
to order a data history CD which will be sent out to you by 
ordinary mail.

5.
6.

7.
8.
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Execute the files in this order: 
1)  Program Installer. 
2)  Historical Data Installer. 
3)  AmiBroker Setup. 

When the AmiBroker Setup runs, it will open a browser-based 
FAQ page explaining how to install the interface necessary for 
AmiBroker to use the Premium Data files. 
 

9.



39Installation

AmiBroker Setup will establish a database in the AmiBroker 
directory, but it will not be usable yet. Here is how to connect 
the two: 

Start AmiBroker.
Using the Tools menu, click ASX-Premium Data. This will 
run a script with seven stages that takes several minutes.

10.
11.
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Using the File menu, select Open Database, select ASX-
PremiumData, click OK.

Here is AmiBroker with BHP in the chart window. 

12.

13.
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Database Setup ‑ Intraday and Real-Time Data

Intraday data is data with bars shorter than a full trading day. Taking 
great care and using a data vendor that supports it, it is possible to 
combine intraday and end-of-day data in the same database. But most 
AmiBroker users who use intraday data maintain a separate intraday 
database. The next few pages describe setting up intraday and real-time 
data.

Free Intraday Historical Data

If you are interested in developing systems with intraday data, but are 
not ready to commit to a real-time data subscription, you can download 
intraday bars into an AmiBroker database and work with them. If your 
systems test out to be profitable, you will eventually need real-time 
data to execute them.

There are several sources of free intraday historical data. Visit http://
www.IntroductionToAmiBroker.com/resources and scroll down to the data 
area for links to some of them. AN Futures sells intraday data for the e-
mini S&P 500, e-mini NASDAQ 100, e-mini Russell 2000, Euro, and Yen 
in 1 minute bar and tick resolution. Visit them at: http://www.anfutures.
com/. They have a demo file, ES0206MG.csv with 1 minute bars for the 
e-mini S&P June 2002 contract – 3/6/2002 through 6/12/2002. The third 
column is the date, with 20306 meant to be 2002, March, 6. 

AmiBroker can accept many date formats, but not that one, so a 
spreadsheet is used to transform the date into one of the acceptable 
formats and 20306 becomes 2002-03-06. The Excel formula to do this 
is: =”200”&LEFT(C1,1)&”-”&MID(C1,2,2)&”-”&MID(C1,4,2), where the 
20306 is in cell C1. Make a copy of the original data file, replace the date, 
and save it with a new name, for example ES0206Mod.csv.

The following procedure will set up a database into which we will load 
the e-mini S&P intraday data. This is the same procedure used to set up 
the Quotes Plus end-of-day database, so the illustrations will be omit-
ted.
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In AmiBroker, from the File menu, select New, then Database.

Working first in the top half of the window:
2.	 In Destination Folder, choose a meaningful name for the 

database – such as IntraDay.
3.	 Uncheck Load this database at startup.
4.	 Click Create.

Now working in the bottom half of the window:
Data Source: (local database)
Local data storage: Enable
Number of bars: 100000
Base time interval: 1 minute
Accept the defaults for Intraday settings
Click OK

The database is established, but has no data in it. The ASCII importer 
will load the data from the csv file using the ASCII Import Wizard in 
the following procedure:

In AmiBroker, from the File menu, select Import Wizard.
Click Pick Files.
Navigate to the location of your modified file and select it.
Click Open.
Click Next.
Fill in the fields.

1.

1.
2.
3.
4.
5.
6.

1.
2.
3.
4.
5.
6.
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Click Next.
Click Finish. The data will be imported and the active chart 
will display the intraday data you just loaded.

In AmiBroker, Save Database.

If you were going to import data from this vendor regularly, you could 
set up a macro in the spreadsheet to convert the date field, and set up a 
custom ASCII format in AmiBroker specifically for that file format.

But, eventually, you will need a real-time data feed to create 1 minute 
bars throughout the trading day.

Delayed Real-Time Data

Some data vendors offer real-time data that has been delayed 15, 20, 
or 30 minutes. It is priced lower than non-delayed real-time data, and 
often is free. From the perspective of a developer of trading systems, 
about the only reasons to use delayed real-time data are to try out a 
data service or to build up a tick-based database. And, since most of 
the high quality data services have a trial period, you can try the real 
thing for the same amount of effort. Trying to place trades using de-
layed real-time data is dangerous to your wealth — a lot can happen in 
15 minutes.

7.
8.

9.
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Real-Time Data

Real-time data can be expensive. Prices range from about $50 to sev-
eral hundred per month for the basic service which includes a limit-
ed number of tickers. There are additional charges for extra services, 
such as charting packages, Level II quotes, or getting data for a larger 
number of issues. Exchange fees, which are set by the exchange that 
clears trades for the tickers listed by them, are also added. There are 
different levels of exchange fees for professional and non-professional 
traders. Exchange fees can add up to several hundred dollars a month. 
Most real-time data vendors have trial periods, but the exchange fees 
charged during the trial are usually not refundable.

Also, check your Internet communications capacity and your commu-
nication vendor’s fair use policy. Monitoring about ten symbols in the 
real-time quote window causes traffic of about 50 MB per hour. Done 
every trading day of the month, this will exceed the fair use limits of 
some vendors. 

 As mentioned earlier, some vendors support combining end-of-day 
and intraday data in the same database. But that can be tricky. These 
steps describe separate intraday databases.

Quotes Plus Real-Time Data

The procedure to set up a real-time data feed using Quotes Plus is:
Begin with a visit to Quotes Plus’ website: http://www.qp2.com/
joomla/index.php.
Pull down the Products menu, select QPFeed, and click Free 
Trial.

Fill in the contact information. You will receive an email from 
Quotes Plus containing a User ID, Password, and the URL link 
to a download utility.

1.

2.

3.
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Follow the link to the download utility and download the 
qpfeed_setup.exe file. 
Execute that file to start the installation. 
Enter your User ID and Password when requested.
Accept all the defaults.
Click Finish to the final dialog and the program will close.

The procedure to connect AmiBroker to the QPFeed is:
Start AmiBroker. 
You will see a message saying that there is a new plug-in from 
qpfeed. Click OK.

Using the File menu, select New, then Database.

Working in the top half of the box:
In the Database folder box, enter the name you want for your 
new real-time database.
Check or uncheck, as you wish, Load this database at startup.
Click Create.

4.

5.
6.
7.
8.

1.
2.

3.

1.
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Now working in the bottom half of the Database settings box:
Pull down the Data Source menu and select QPfeed Real 
Time Data Plugin.
Click Enable local data storage.
Enter 25000 for number of bars.
Pull down the Base Time Interval menu and select 1 minute.
Click Configure.  
The configuration menu will appear.
Select the categories you want to receive.
Check Exclude symbols without quotes.
Click Retrieve.
Click Close.  
Return to the Database settings screen.
Click OK.

1.

2.
3.
4.
5.

6.
7.
8.
9.

10.
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At this point, you have a database established to store 1 minute bars 
and the QPFeed ready to supply data. To bring up a chart:

Using theAmiBroker Symbol menu, select New.
Type in a symbol, say SPY.  
In a few seconds the chart will appear.

1.
2.
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DTN IQ Real-Time Data

The procedure to set up a real-time data feed using DTN IQ Feed is:
Visit the DTN IQ Feed web site at: http://www.iqfeed.net

Click Get Free Trial Now. Complete the application forms. The 
trial is exactly the same as the subscription version. The trial 
turns into a subscription at the end of the trial period, unless 
you call to cancel it. DTN will send an e-mail with your User 
ID and PIN.
Return to that web site and Click Download Client. The 
current version is a file named iqfeed_client_4_4.exe, and is 
about 3 MB.

1.

2.

3.
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Run iqfeed_client_4_4.exe. 
Accept all the defaults. When you click finish on the final 
screen, the iqfeed program will be installed on your computer.

To set up an AmiBroker real-time database using DTN IQFeed:
In AmiBroker, using the File menu, select New, then Database. 

Working in the top half of the box:
In the Database folder box, enter the name you want for your 
new real-time database.
Check or uncheck, as you wish, Load this database at startup.
Click Create.

4.

1.

1.

2.
3.
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Now working in the bottom half of the Database settings box:
Pull down the Data Source menu and select DTN IQfeed data 
Plugin.
Click Enable local data storage.
Enter 25000 for number of bars.
Pull down the Base Time Interval menu and select 1 minute.
Click Configure.  
The configuration menu will appear.
Note that DTN IQ has a bad tick filter. Accept the defaults. 
Click OK  
Return to the Database settings screen.
Click OK. 

1.

2.
3.
4.
5.

6.
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The IQ Connect Login will appear.
Enter your Login.
Enter your Password or PIN.
Click Connect. Your computer will communicate with the 
DTN IQ server.

To bring up a chart:
Using theAmiBroker Symbol menu, select New.
Type in a symbol, say SPY.  

8.
9.
10.

1.
2.
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In a few seconds the chart will appear. Add other symbols, 
open the Realtime Quote Window, and continue.
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Tick data

Tick data refers to market data that represents the time and transac-
tion price, and perhaps the volume, of every trade. Depending on the 
exchange and the data vendor, the tick data stream may also include 
other information, such as changes in the bid price, the asked price, 
the volume on each side. Just as it is possible to make display bars that 
represent a given amount of time, say 1 minute, it is possible to display 
bars that represent a given number of ticks, say 15 ticks.

In the opinion of this author, tick data is not appropriate for use by in-
dividuals and small trading companies. The highest quality tick data 
includes an information packet for every transaction. Some of the dif-
ficulties with tick data include: high cost; very high volume of trans-
actions; erroneous transactions (called bad ticks ‑ see example below); 
dropping of transactions when exchange activity increases (fast market 
conditions) or when communications capacity is reached. 
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Tick data is best used by larger organizations that have high capacity 
equipment, redundant data feeds, and staff devoted to monitoring and 
correcting the data.

To use tick data in AmiBroker, the Professional version is required.

If you want to experiment with very frequent data, try working with 1 
minute bars instead of tick data.

This book will not discuss tick data further.


